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Preface

SciAn is a scientific visualization and animation program for high-performance

graphics workstations. This document describes version 0.80 of SciAn. Since SciAn is

still under development, there are errors present in the program and some features not

yet implemented. Even in its present form, SciAn has proved to be a useful tool for

researchers in many fields. We hope you will find it useful as well.

This is the user’s manual for SciAn. It covers the basic operation of SciAn and should

provide enough information to learn and begin using the program. SciAn Reference

Manual, referred to in this manual simply as the reference manual, contains more

technical information, including installation instructions. If you are seeking

information about something in SciAn and you do not find it in this manual or in the

reference manual, look at the files in the pub/SciAn/technotes directory  at

ftp.scri.fsu.edu, and also in the pub/SciAn/release directory check the util

and examples subdirectories. If you cannot find it there, write to the authors at

scian-info@scri.fsu.edu.

SciAn is being developed on Silicon Graphics workstations and has been ported to

IBM RISC System/6000 workstations with graphics cards that support the IRIS GL

Graphics Library option. We plan to port it to other machines with high-performance

graphics capabilities.

SciAn is a product of a university research environment. We believe very strongly in

collaboration and cooperation, as well as in sharing results. This is the main reason

that we offer SciAn at no charge. We hope that all users of SciAn become active users,

contributing to its development as well as using it for research. We also ask that if you

find SciAn useful in your work, you credit the Supercomputer Computations

Research Institute and Florida State University in your publications.

SciAn mailing list

There is a SciAn mailing list, scian@scri.fsu.edu, which is used for general

discussion of SciAn as well as announcements of new versions and bug fixes. To get

on the SciAn mailing list, send electronic mail to scian-info@scri.fsu.edu.

Downloading SciAn does not automatically put you on this list.

By making sure you are on the electronic mailing list for SciAn, you will be notified

of any work-arounds for bugs that have been discovered. You will also receive

notification of the availability of subsequent versions of SciAn which fix these bugs

and implement new features. Perhaps most importantly, you will be able to read and

participate in discussions of using SciAn in research applications and of desired

features and future directions of SciAn.
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Reporting bugs

We appreciate your help in testing SciAn. Unfortunately, you will most likely find

some bugs in the program.

If you find a bug, please try to replicate it while logging to a file from within SciAn

(use the -l filename switch on the command line). Some bugs will produce error

messages to the standard error device, and these error messages will also appear in the

log. If the bug results in a core dump, keep the core file too, just in case we are unable

to duplicate the problem with just the log.

Report the bug via electronic mail to scian-bugs@scri.fsu.edu. Include the log

file with your report. You don’t need to send the core file, but we might ask you to

send it later.

If you can’t replicate the bug, just let us know what you do know about it.

Future development

We are always interested in hearing suggestions for improvements in SciAn, though of

course we cannot guarantee that all will be implemented. Send your ideas for

improving SciAn or your list of most desired features to the SciAn mailing list at

scian@scri.fsu.edu.

We are also interested in making SciAn work with more file formats, disc recorders

and other recording devices such as frame-accurate VCRs, and display hardware, such

as stereo viewers. If you have such devices that you would like to use with SciAn, then

perhaps we can work together. You may write to the authors directly at scian-

info@scri.fsu.edu.
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Introduction

SciAn (for Scientific Animation) is an interactive scientific visualization program

developed to satisfy needs at the Supercomputer Computations Research Institute

(SCRI) at Florida State University (FSU).

SCRI is a multi-disciplinary research program. It includes researchers in many fields

where scientific visualization has long been used, such as chemistry and meteorology,

and many fields where scientific visualization is just now coming into its own, such as

theoretical physics. This has presented us with exceptional opportunities for sharing

visualization techniques among disciplines and bringing visualization to new fields.

There has long been a tradition at FSU of using scientific visualization as part of the

research process itself rather than simply as an educational tool after the research has

been completed. James O’Brien and Mark Luther at the Mesoscale Air-Sea

Interaction Group pioneered this approach at FSU based on work stretching back

three decades. The idea is to generate animated visualizations quickly and easily on a

daily basis, the way people use program listings. The ability to make a video of the

day’s data, look at it once and then discard it, greatly enhances the process of

research. The increased speed and ease qualitatively affects how visualization is used.

Researchers can use visualization at a very early stage as a tool to debug programs or

quickly to cull out approaches.

SciAn was developed within this environment to meet our needs. It is designed to be

usable very easily and quickly, requiring very little specialized knowledge about

computer graphics.

SciAn has been designed along the lines of object-oriented drawing packages rather

than along the lines of textual or visual programming systems. The process of using

SciAn to develop a visualization is one of progressive refinement. SciAn uses defaults

and heuristics to get the first visualization on the screen with minimal effort. Once

there is an image to work with, the visualization is refined using a wide range of tools.

Ultimately, a video animation can be made within SciAn using an automated

videodisc recorder driver.

While still under development, SciAn has been used to produce visualizations of data

in many scientific fields: meteorology, quantum chromodynamics, computational

chemistry, genetics, computational fluid flow, lattice gauge theory, and chaos theory.

It has been used to make video animations in just two hours from initial discussion of

the problem to the tape in hand, in a real research environment on real problems.

SciAn has already shown its value as a research tool, but we have barely scratched the

surface of what we think can be done with the user interface design.
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By releasing this still preliminary version, we hope to include more researchers in the

evolution of SciAn. At SCRI, we have always benefited from being in a diverse

community of scientists. We hope that researchers from other institutions will become

a part of this diversity.
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1

 

Getting Started with SciAn

This chapter explains the basic concepts of SciAn. It starts with the concepts behind

the user interface, explains the on-line help system, and concludes with a short tour to

give the feel of using the program. By the time you finish this chapter and complete

the tour, you should have enough experience with SciAn to be able to experiment

with every aspect of interactive use. You will also have a basic understanding of the

design and organization of SciAn which will be important as you read further.

User interface concepts

SciAn is designed with a graphical user interface. Many of the basic concepts should

be familiar to anyone who has ever used any computer with a mouse.

Interaction with SciAn is done through windows on the screen. Graphical objects

within windows represent objects within the program. Manipulating and editing the

screen objects results in changes to the underlying objects.

Whenever possible, actions are performed by direct manipulation, such as sliding

controls and dragging icons. Some actions are performed by first selecting the objects

to use and then pressing a button or choosing a menu item to perform the action. The

keyboard is used to enter text and numbers. There are function keys for some

commonly performed functions, and some keys modify mouse operations, but for the

most part, the keyboard is not used to enter commands. There is also a scripting

language which is mostly used for generating animations.

If you are already familiar with graphical user interfaces and are in a hurry to get to

the tour, you may want to glance through this section only briefly.

Using the mouse

SciAn uses a three-button mouse as shown in Figure 1-1.

The left mouse button is used to operate controls, select and move objects such as

icons, select text for editing, and move visualization objects within a space. Whenever

this manual mentions clicking, pressing, or dragging, this is the mouse button to use

unless otherwise specified.

The right mouse button is always used to bring up menus. Press with the right mouse

button in any window to bring up menus appropriate to that window. It does not

matter where in the window you press, so long you press in the interior of the window.
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Right Button
Used to bring up 
menus in all 
windows

Left Button
Used to press 
controls and 
to select and 
move objects

Center Button
Used to rotate 
spaces and to 
extend selections

Figure 1-1. Three-button mouse

The center mouse button is used to rotate visualization objects within a space. It also

provides a shortcut way of extending a selection (see “Modifier keys” below).

Clicking the mouse means moving the pointer to an object and quickly pressing and

releasing the mouse button. The action occurs as soon as the mouse button is pressed

down. Clicking is used to select icons and to select objects in visualization spaces.

Double-clicking means clicking twice in rapid succession. Double-clicking is used to

snap controls to useful values or to open or show the controls of objects represented

by  icons.

Pressing with the mouse means clicking and holding down the mouse button.

Pressing is used to operate buttons. For most buttons, the operation is not performed

until you release the mouse button. You can drag the mouse pointer outside the

control before releasing, and the operation will not be performed. Some buttons, such

as the arrows on the end of a scroll bar, perform an operation repeatedly while the

button is being held down.

Dragging with the mouse means pressing and moving the mouse before releasing the

button. This is used to move control pointers, icons, visualizations objects, etc. You

can also drag through editable text to highlight it.

Modifier keys

Some keys on the keyboard modify the operation the mouse performs. Press one of

these keys and hold it down for the duration of the operation.

The Shift key does one of two modifications: extend or constrain. The extend

modification is used when making a selection. For example, clicking an icon with the

left mouse button normally selects that icon and deselects any icons that were already

selected. If you hold down the Shift key, it will instead extend the selection to include

the new icon without deselecting the others.
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Hint In most cases, the center mouse button works like the left mouse button with the Shift

key held down.

The constrain modification limits a motion performed by a press and drag to

convenient values or directions. For example, holding down the Shift key when

moving a slider with a scale constrains the values to tic marks. Most controls have

constrain features.

The Control or Alt key does the alternate modification. As you become more

familiar with SciAn you will find this modification is used to provide some convenient

alternate way of performing an operation, to provide a convenient short-cut, or to

perform automatically some related operation.

X
Windows

In order for SciAn to be able to use the mouse buttons and the modifier keys, it has to be

allowed to see the key presses by the window manager. It is possible to configure some

X Windows systems to hide certain combinations from applications. SciAn works fine with

the default configuration of the Silicon Graphics and IBM RS/6000 windowing systems. If

you have made extensive modifications or are using different window managers, you

may have some difficulty running SciAn.

Using menus

To bring up a menu, press with the right mouse button in a window until the menu

pops up. Drag to the item that you want to choose, and release the button. Menus may

have submenus, which are indicated by an arrow on the right of the item. When you

move the mouse over these menu items and drag to the right, the new menu will

appear. It is a good idea to activate the menu well away from the right side and

bottom of the screen or the submenus may be difficult to use.

IBM On some IBM systems, the menus are implemented differently. To bring up a menu,

press and release the right mouse button. The menu will appear. To choose an item, click

once more over your choice. One of the unfortunate side-effects is that you cannot

change your mind and choose not to press any items at all. If this happens, try clicking in

the title of the menu to make it go away. If this does not work, it should always be safe to

choose the Help item. The behavior of menus may vary depending on your version of

the operating system.

If you think the wrong menu items are being highlighted and grayed out, your copy of

SciAn may not be installed correctly. Check the installation instructions in Chapter 1 of

the reference manual to find out what to do.

Using controls

SciAn has many types of controls. Some controls, such as buttons and scrollbars,

should be familiar to anyone who has used any graphical user interface. Other

controls are unique to SciAn. This section very briefly describes some of the more

common controls. Other special purpose controls are described in the sections of the
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manual where they are used. The figures for the tour of SciAn later in this chapter

contain many examples of the controls discussed here.

Controls are operated by pressing and dragging and may also be operated from

within scripts (see Chapter 8). Controls appear as objects on the screen. They appear

bright and shaded when active and appear dull and flatter when inactive. Some

controls, such as scroll bars, also incorporate some color in their appearance when

active. Controls may control a variety of attributes, from single numerical parameters

to complete color palettes.

Buttons

Buttons appear as rectangular bumps with labels. To press a button, move the mouse

inside it and press the left mouse button down. The button will light up as long as the

mouse button is down and the pointer is in the button. To complete the operation,

release the mouse button while the pointer is still inside. If you move the pointer

outside the button before releasing, the operation will not be performed.

Plain buttons appear as rectangular bumps with text labels inside. Plain buttons are

usually used to perform some operation on all selected objects or to reset various

parameters.

Check boxes appear as square bumps with labels on the right side. Check boxes are

usually found in control panels and control some attribute of the object which can be

on or off. When a check box is on, a small check mark (√) appears in the box. Click a

check box to toggle it between on and off.

Radio buttons look similar to check boxes but show a small asterisk (*) instead of a

check mark when on. Radio buttons are found in groups and control an attribute that

can have several values. Radio button groups may have a box around them with a title

that identifies the attribute they control. Only one radio button in a group can be on,

and this determines which value is used for the attribute.

Icon buttons are similar to plain buttons but contain icons and sometimes labels. They

are often used as radio buttons, to control which space panel tool is selected or which

set of controls is shown in a control panel. When an icon button is on, the icon is

highlighted with color.

Sliders

Sliders are used to adjust a value within a range. A slider has a pointer which moves in

a track and may also have a numbered scale. When the slider is active and can be

moved, the track will appear pastel green. To move the slider to a new value, pick up

the pointer and drag it to the desired value. You can also move a slider to a value by

clicking in the track. Hold down the Shift key while dragging a slider with a scale to

constrain values to tic marks on the scale. Sliders may have readouts, which are

editable text boxes showing the current value of the slider.

Scroll bars are variations on sliders. A scroll bar has a sliding rectangular bar which

moves in a track and an arrow button at each end. They are always associated with an

icon corral, text box, or control area which may have an interior larger than the area
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shown. Drag the sliding bar to move the portion displayed. Press in the arrow buttons

to move a little at a time in the direction of the arrow. The motion will continue as

long as you hold down the mouse button.

XY controls are sliders for two values. An XY control has a rectangular area in which

a square indicator can move freely. XY controls are used to edit two closely related

values, such as the control for specular highlights. Hold down the Shift key while

dragging in an XY control to constrain motion to strictly horizontal or vertical

directions. Double-click to snap the control to the center, the center of a side, or a

corner, whichever is closest.

Color wheels

Color wheels vary the hue and saturation of a color. They look like the familiar

textbook color wheel with a small cross to indicate the chosen color. Click on any

point within the wheel to set the color to that value. Near the perimeter of the wheel

are the more saturated colors. The less saturated colors are more toward the center.

White is at the very center. Hold down the Shift key while dragging in a color wheel

to constrain to half- or full-saturation colors. Double-click to snap to the closest half-

or full-saturation version of one of the six pure hues (red, green, blue, cyan, magenta,

or yellow) or white.

Text boxes

Text boxes contain text. Editable text boxes on control panels appear as pits with pink

backgrounds. There is another kind of text box used for annotations in spaces, which

is described in Chapter 7. The two kinds look different, but the text is edited the same

way.

To insert text, click once where you want to insert text and start typing. To delete the

last character typed, press the Backspace key. You can also use the arrow keys to

move the insertion point.

To replace or delete a range of text, first highlight the range by pressing at the

beginning and dragging through to the end of the range. You can also click once at

the beginning of the section you wish to highlight, then hold down the Shift key and

click at the end of the section. Double-click on a word to highlight it.

Type new text to replace the highlighted text. Press the Backspace key to delete the

highlighted text. Choose the Cut Text item from the Text menu to remove the text

and put it on the text clipboard (an internal buffer to hold text). Choose the Copy

Text item to put the text on the clipboard without removing it. Choose the Paste

Text item to paste the contents of the clipboard at the insertion point or replace

highlighted text.

Many text boxes control parameters. The text in these text boxes is checked for

validity whenever you press the Return or Enter key or click in another text box. If

there is a syntax error or other problem with what you have entered, you will see a

dialog window explaining what the problem is.
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Some text boxes are used to enter numbers. Numbers are expressed in standard

floating point format as used in the C programming language. This format should be

familiar to anyone who has ever used C or FORTRAN and expresses numbers as a

mantissa and an optional exponent separated by the letter E. For example, 3.2×10-14

is entered as 3.2E–14. There should be no spaces in a number.

There are three special strings which can be used in place of a numerical value:

Infinity, –Infinity, and Missing. These represent plus and minus infinity and

missing data, respectively. They are only used in a few places, such as the minimum

and maximum values of contours.

Hint You can just use the first letter, I or M, to represent infinity or missing data. Whether it is

in upper or lower case does not matter.

Switches

Switches control the flow of data, as switches in a railroad line control the movement

of trains. A switch appears as a black arrow from two or more data sources to one

output. The line which is on appears thicker. To flip a switch, click on the desired

line.

Switches are used when one of several input sources is used to control an attribute of

an object. An example is in the Color control panel, where a switch controls whether

the color comes from a fixed color or a color field.

Icons

Icons are small pictures that represent objects. Icons are used to represent files,

datasets, visualization objects, sets of attributes, and just about every other object that

can be accessed within SciAn.

Icons are found in icon corrals. These appear as pits with light blue backgrounds.

Some icon corrals have scroll bars which can be used to scroll through all the icons.

Icons can be selected for further operations involving buttons or menu items, dragged

into other icon corrals, or double-clicked to perform a predefined common

operation. Some icon corrals, such as the Contour Field corral of a contour

visualization object may contain only one icon. A selected icon is colored bright

yellow.

To select an icon within a corral, click on it with the left mouse button. Normally, all

other selected icons will be deselected. Hold down the Shift key while clicking on an

icon to extend the selection. You can also press in the blue background of the corral

itself and drag out a selection rectangle around the icons you want to select. When

you let go, all the icons within the rectangle will be selected. If the Shift key is held

down, the icons within the rectangle will extend the selection.

To drag a single icon from one corral to another, press in the icon and drag it to the

destination. A red ghost of the icon will follow the mouse pointer around. When you

have moved the ghost to the destination, release the mouse button. To drag several
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icons, select them all and drag one of them in the same way. Do not hold down the

Shift key when dragging.

Note Some systems do not support dragging icons between windows. You will notice this

because the red icon ghost will stop at the edge of a window. To perform the same

operation, select the icons to drag and choose Pick Up from the Object menu. Then click

in the window where you want to drop the objects. It may not be as elegant as dragging

the icons, but it works. If you have function keys on your keyboard, F8 does the same

thing as Pick Up.

Shared objects

When an icon has been dragged to a corral, a new icon will appear in the corral. The

original icon is never deleted. The newly created icon and the original icon both

represent the same object (unless the icon represents a template object as described in

Chapter 4). When two or more icons represent the same object, the object is said to be

shared. Operations to one icon representing the object affect the shared object

wherever it appears. You can always make a particular object local to one window by

selecting the object and choosing Make Local Copy from the Object menu. The

object will be copied and the new copy used.

For example, dragging a light source icon from one visualization window to another

allows the light to illuminate both spaces. All changes to one light, such as changing

the color or position, will affect both spaces, because there is really only one light

object controlling both spaces. If you really want there to be two separate lights, select

the light in one visualization and choose Make Local Copy.

Some icon corrals can only contain one icon or only one icon that represents a

certain kind of object. In these cases, dragging a new icon into the corral will replace

the old icon. For example, a visualization window can only have one clock. If you

drag a new clock icon into the corral of a visualization window, the old clock will be

replaced. Because the clock is now shared, the one clock will synchronize both

visualization windows to the same time.

Selecting

Besides icons, other objects such as drawings and annotations, can be selected for

further operations. In general, to select an object, click on it. If it is selectable, it will

be selected, and all other objects will be deselected. If you don’t want to deselect all

other objects, press and hold the Shift key while clicking or use the center mouse

button instead of the left. Some objects, such as icon corrals, also allow you to press

and drag a rectangle around objects to select.

Selected objects are highlighted to let you know they are selected. For example, icons

show up in bright yellow, and annotations have a rectangular border with handles.

The current object

Each window may have only one current object. The current object receives all the

key presses in its window. For example, when a text box is current, all the key presses
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are used for editing text. When a slider is current, the arrow keys nudge the value up

and down.

Objects are made current the same way they are selected—by clicking on them.

However, an object can be current and not selected. For example, clicking on a slider

makes it current so that it receives the arrow keys, although the slider is not selected

and clicking on it does not deselect all other objects.

Windows

All the controls, icons, and visualization objects in SciAn appear within windows on

the screen. The windows are provided by the native operating system of the computer.

Much of the behavior, such as resizing and moving windows, varies from system to

system. In general, anything in the interior of the window is the responsibility of

SciAn, but anything involving the window frame is the responsibility of the operating

system. Consult the documentation for your system for more information.

Icon
Windows

Some systems allow you to turn your windows into icons. SciAn works fine with this,

however, it is not a good idea to turn a window into an icon and then forget about it. This

is because SciAn sometimes needs to bring to the top a window which has been made

into an icon. SciAn cannot turn the icon back into a window, so you must do it yourself.

SciAn uses multiple windows. At any one time, only one window can be current. How

to select the current window varies from computer to computer. On the default

Silicon Graphics configuration, the window with the mouse pointer within it is always

the current window. On some X windows systems, the current window is selected by

pressing in its title bar. In SciAn, all of the key presses go to the current window.

Mouse operations, such as selecting icons and bringing up menus, occur in the

window where the mouse is pressed, regardless of which window is current.

Because of the way windows are configured on some systems, dragging icons from

one window to another may not work. On these systems, the red icon ghost will not go

outside the window bounds. Use Pick Up in the Object menu instead.

Dialog windows are used by SciAn to ask questions and give information. They

appear as windows with colored borders and a group of buttons across the bottom to

provide choices. Dialog should be answered as soon as they appear. Most dialog

windows have a Cancel button, which dismisses the dialog and cancels the operation

in progress. Dialog windows with editable text boxes have a Revert button, which

causes the text to revert to its original value. Dialog windows also usually have an OK

button, which dismisses the dialog window and continues with the operation. In some

cases, this button may have another name which better describes the operation.

In some dialog boxes, one of the buttons will be highlighted with a black rectangular

border around it. Pressing the Return key when this window is current will have the

same effect as pressing this button.
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Using built-in help

There is an on-line help system built into SciAn. Help is given through a window

which shows descriptions of general topics and help in context about any object in

any window.

To show the help, bring up the main menu and select the Help item. You can also

bring up the help window by clicking anywhere in the title window of SciAn. A

typical help screen looks like Figure 1-2.

At the right is a group of radio buttons which specify topics. To get help on a topic,

press its button. The help text will appear in the text field at the left. If there is more

text than can fit on the screen at one time, you can scroll up and down using the scroll

bar.

Help

Introduction

Welcome to SciAn, a scientific visualization and animation package

developed at the Supercomputer Computations Research Institute

(SCRI) at Florida State University.

This on-line help system is intended to help you get started using

SciAn.  To see help on a particular topic, click with the left mouse

button on the radio button on the right showing the name of the

topic.

If there is more help text than can be shown on the screen, move

up and down through the text using the scroll bar on the right.
Help In Context

Menus

Function Keys

Modifier Keys

Using the Mouse

Command Line

Reporting Bugs

Revision History

Credits

Copyright

Introduction

Figure 1-2. Help window

Help in context

The most useful item on the help window is the Help In Context button, which

provides reference information on most objects in SciAn. When you press this button,

your mouse cursor turns into a little question mark. You can then click on any object

in any window to get information on what it is, what it does, and how to use it.

IBM The IBM version doesn’t change the cursor yet.

The F12 function key provides a shortcut to this feature without having to bring up

the help window first. Press the F12 key and the cursor will turn into question mark.

When you click on an object, the help window will come to the front automatically.
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Be careful if you turn the help window into an icon. SciAn will only create one help

window, which is used for all help. If the help window is an icon, SciAn will not be

able to open it for new help. You must open it yourself.

Quitting SciAn

To quit SciAn, move the mouse pointer to any SciAn window and press and hold the

right mouse button. The main menu will appear. Move the mouse pointer to the Quit

SciAn item and release the button. (On the IBM RS/6000, you will need to click on

Quit.) You will see a dialog window asking if you really want to quit. Press the OK

button.

SciAn will also automatically quit when all the windows have been closed.

Hint You can avoid going through the Quit confirmation dialog by pressing and holding the

Control key while you choose Quit from the menu.

A quick tour of SciAn

This section is a basic hands-on tour which will give you a feel for how SciAn works.

It is a good idea to go through this tour before continuing with the manual.

The tour assumes that you have the tour files distributed with SciAn and that you

know the name of the directory where the files are located. Before you begin the tour,

please find out this information.

The tour involves no premade scripts or logs. You will be approaching the data the

same way a researcher approaches the data for the very first visualization. The datasets

are from Doppler weather radar of a thunderstorm in the Magdalena Mountains near

Socorro, New Mexico. There are two files containing 3-D fields from Doppler

weather radar. There is also a 2-D scalar field which gives the elevation of terrain

under the thunderstorm.

Ready to begin the tour? Check the following:

• SciAn has been installed on your machine

• You know where the tour files are located

If both check out, you are ready to begin.

Starting SciAn

Start SciAn by entering

scian

on the console and pressing the Return key. SciAn will bring up a window showing

the program title, credits, and copyright notice.
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Opening a file browser

Move the mouse pointer to the inside of the title window and press and hold the right

mouse button. (On the IBM RS/6000 workstation, press the right mouse button and

release.) SciAn will bring up the main menu. There are two important items which are

always available in the Main menu. The Help item at the top of the menu brings up a

window which gives on-line help. The Quit SciAn item at the bottom of the menu

causes SciAn to quit. There is also the Preferences item which opens a window

allowing you to change the settings of various parameters controlling the behaviour

of SciAn. The other items are submenus which appear differently in different

windows.

Move the mouse pointer to the File item and then move to the right. The File submenu

will appear. Move the mouse pointer to the New File Browser item and release the

mouse button. (On the IBM RS/6000 workstation, press the button and release.)

SciAn will bring up a dialog window asking you for the name of the directory to

open.

Dialog
windows

A dialog window requests information that is needed before SciAn can proceed with an

action. You can always tell a dialog window by the thick colored border around it. Most

dialog windows have two buttons: an OK button and a Cancel button. The OK button

proceeds with the operation. The Cancel button cancels it. Dialog windows with text

boxes also have a Revert button, which reverts the text to the original text shown in the

window.

Type the name of the directory where the tour files reside into the text box in the

center of the dialog. You can highlight text to edit it by clicking and dragging

through the text with the left mouse button. When you type on the keyboard, the new

text will replace the highlighted text. You can also set an insertion point by clicking

between two characters. New text that you type will appear between the characters.

Mouse
buttons

The right mouse button always brings up the menus, and the left mouse button is used

for selecting, pressing, and dragging objects. The center mouse button is used for

rotating a space, as you will see later.

After you have entered the directory name, press the OK button using the left mouse

button. SciAn will bring up the directory containing the tour files, which should look

something like Figure 1-3.
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/scri4d/a/users/lyons/scian/tour"! 
Z.stf
STF"! 

W.stf
STF

"! 
Terrain.stf

STF

Files

Show all files

Show SciAn files only$#
Open Parent

Open Set Format Show Info

Figure 1-3. File browser

SGI The Silicon Graphics workstation may require you to choose a window location before the

window is opened. If so, you will see a red rectangle attached to your mouse pointer.

Click on the screen where you want the upper left corner of the window to appear. You

can change this behavior with the New Window Location option in the Preferences

window (see Chapter 10).

In the center of the window is an icon corral which contains icons for all the files in

the demo directory. If the corral is not large enough to show all the icons in the

window, you can use the scroll bars at the right and bottom of the icon corral to scroll

through all the contents. Press on the long raised bar in the scroll bar on the right and

drag downward to see files lower in the corral.

Reading the data files

There are three files of interest: Z.stf, which contains a scalar field defined over a

regular grid giving the reflectivity; W.stf, which contains just the vertical component

of wind velocity over the same grid; and Terrain.stf, which contains the terrain

elevation. For now, ignore any other files which may appear in the same directory.

SciAn has recognized these files by the .stf extension as being in the Simple Text

File format.

Select the icons of Z.stf, W.stf, and Terrain.stf. First click on one icon with the left

mouse button. It will turn yellow, which indicates that it is selected. To extend the

selection to include the other icons, hold down the Shift key and click on the other

icons. Alternately, you can press in the light blue background to the upper left of all

the icons, hold the mouse down, and drag a selection rectangle around all the icons to

select them. When you release the mouse button, the icons will be selected.

When all three icons have been selected, press the Open button. The files will be

opened into a new Datasets window, shown in Figure 1-4. In this example, each file
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contains a single dataset. In general, this need not be true. One file can contain several

datasets, and a single time-dependent dataset may reside in several files.

Datasets"! 
Terrain%$#

W

%$#
Z

Visualize Visualize As...

Show Controls Modify...

Figure 1-4. Datasets window

Visualizing the data

To visualize the data, select the three datasets and press the Visualize button. SciAn

will examine the data and automatically choose visualization techniques. A

visualization window will appear, such as shown in Figure 1-5.

Visualization 1! $#'&*)-,0/432
Observer 1

765
Renderer 1

:98
Light 1

:98
Light 2

"! 
Clock 1

=<;
Isosurface 1

Z

=<;
Isosurface 2

W

@?>
Mesh 1
Terrain

Figure 1-5. The first visualization
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In the middle of the window is a 3-D view called a space which shows all the objects

in the visualization. On the left of the space is a series of icon buttons to select space

tools, which allow you to interact with the space in various ways. The Space Selection

tool is currently selected. On the right of the space is an icon corral filled with icons

that represent the visualization objects within the space and space controllers such as

lights, the observer, the clock, and the renderer, which control how the visualizations

are shown.

SciAn has chosen visualization objects based on examining the data. In this case, it

has chosen isosurface objects (surfaces of constant value) for the W and Z fields and

a deformed colored mesh for the Terrain field. Generally, SciAn tries to make

reasonable assumptions about the kind of visualization to use so that you can get an

image up on the screen as quickly as possible. You can always change parameters and

choose additional kinds of visualizations later.

Now that there is something on the screen to work with, you can start refining the

visualization. First, rotate the space up to get a better viewpoint. Press and hold the

center mouse button near the bottom middle of the space and drag slowly up. The

space rotates as if it were covered by a large, invisible trackball. By the position where

you press the mouse and the direction you drag it, you can rotate around any axis.

This virtual trackball becomes easier to use with practice. Soon the rotation will feel

completely natural. To constrain rotation to one of the principal axes of the space,

hold down the Shift key before pressing the center mouse button. Try this now. Hold

down the Shift key and drag the space from side to side. Notice how the objects rotate

around an axis vertical to the terrain.

If you release the mouse button before stopping the mouse, the object will continue to

rotate in the direction you have spun it. This is called rotation inertia, and it can be

turned on and off from within the Preferences window. Click in the space with the left

or center mouse button to halt the rotation.

If you get lost with the rotation, you can double-click with the center mouse button to

snap the view to the nearest straight-on orientation.

The left mouse button moves the visualization within the space. Press and drag with

the left mouse button now to move the visualization up a little bit.

To bring the visualization a little bit closer, use the Observer controller. Click on the

Observer icon to select it. Using the right mouse button in the window, pull down the

main menu, go into the Object submenu, and choose Show Controls. A control

panel will appear, as shown in Figure 1-6.
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Observer 1

View Type

Crystal Eyes

Anaglyphic Stereo

Crosseyed Stereo

Orthographic

Perspective

Binocular Spacing:

0.4! Reset Position

Reset Rotation$#Look At:

Up Vector:

Origin:

Figure 1-6. Observer control panel

On the left is a Perspective control which shows a bird’s eye view of the observer

looking at the scene. The observer is represented by a hieroglyphic eye at the bottom

of the control. Two diagonal lines show the angle of view. The space is represented by

a wire frame cube between the sight lines. Horizontal lines show near and far clipping

planes. To bring the space closer, pick up the cube with the left mouse button and

drag it downward toward the eye.

Other controls in this panel provide ways to get orthographic and stereo views, change

the spacing between the eyes for stereo, and reset rotation and motion if you get lost.

3 D Can your workstation do full color mode? Do you have a pair of red/cyan anaglyphic

stereo glasses? If so, don’t put them on yet! The bright colors in the terrain will confuse

your visual cortex when split up into two images. However, the gray isosurfaces work very

well. If you can’t wait to see the 3-D effect, click on the Terrain icon and choose Turn Off

from the Object menu. Click the Anaglyphic Stereo button and put on the glasses. The

3-D effect is particularly nice when the object is rotating and the window is large and

unobscured. When you are done, turn the terrain back on and switch back to perspective

viewing.

When done bringing the visualization closer, close the control panel by choosing

Close from the Window menu. On the Silicon Graphics IRIS workstations, you can

also use the window manager’s Close command on the window controls menu in the

button at the upper left corner of the window frame, or simply double-click the menu

button. Don’t do this on the IBM RS/6000, as an error in the implementation of the

window manager causes SciAn to abort.

Adding color

One thing is immediately obvious from looking at the data. We know that there are

two scalar fields visualized in the center, but we cannot tell them apart because they

are both shown in shades of gray. The next step is to change the color of one of the

isosurfaces.
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Select the icon for the vertical wind velocity component, W . Choose the Show

Controls item from the Object menu just as you did to show the observer controls. A

visualization object control panel will appear, as shown in Figure 1-7.

Isosurface 1 ! 
Isosurface$#

Missing Data'&
Surface*)
Lines-,10/WSource Field
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1.55

Enclose

Low Values

High Values

Get Normals

From Geometry

From Data

Figure 1-7. Isosurface control panel

At the right is a series of icon buttons. Each button represents a set of attributes of the

visualization object. Clicking on different icon buttons causes different control panels

to appear.

Click on the icon named Color to bring up the color controls. (You may have to use

the scroll bar beside the icon buttons to bring the Color button into view.) The

controls will appear as in Figure 1-8.

Isosurface 1 ! 
Surface$#
Lines'&
Dots*)
Color-,

Bounds

Color Field

Edit Palette

Fixed Color Brightness

+*)
Base Color

Translucent

Transparent

Color Shading

Smooth

Flat

Figure 1-8. Color control panel
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At the upper left of the panel is a simplified data flow diagram which shows that either

a fixed color or a color field can go through a brightness control and result in the

color of the object. You can color a visualization object by a field by dragging the

field’s icon into the color field box. For now, however, we are only interested in the

fixed color. Turn the isosurface red by pressing in the Fixed Color color wheel near

the red at its right. The isosurface will immediately turn red.

Now the two isosurfaces can be distinguished, which reveals another problem. It is

clear that the red updraft isosurface is not entirely visible because it is within the gray

reflectivity isosurface. To fix this problem, make the gray isosurface translucent.

Bring up the control panel for Z and go to its color attributes. Press the Translucent

check box at the bottom of the panel. The isosurface will become translucent, and

you will be able to see the updrafts inside it.

If your hardware supports alpha blending, there may also be a Transparent check

box. Uncheck the Translucent check box and check the Transparent check box

instead. You may also need to pull down the Brightness slider a little bit so that the

whiteness of the surface is not overpowering. Notice the difference between this effect

and the translucency effect. Either or both can be useful, depending on the data.

Holes If you look closely, you may notice that there are holes in the reflectivity isosurface. This

shows actual missing data points in the dataset. The isosurface algorithm used by SciAn

will never produce anomalous holes with continuous data. You can fill in the holes using

the Isosurface control panel, but by default, SciAn always tries to give as accurate a

picture of the data as possible. If there are holes in the data, SciAn shows them—either

by leaving gaps in the visualization or by coloring the holes a dull gray.

Changing the isosurfaces

SciAn chose the initial values of the isosurfaces based on an examination of the data.

However, these can easily be changed. Bring up the control panel for the vertical wind

velocity, field W. This time, instead of using the menu, just double click on the icon

with the left mouse button. When the control panel comes up, click on the Isosurface

button. Change the value of the isosurface from 5 m/s to 7 m/s. You can do this two

ways. One is to edit the text in the Isovalue slider readout, the same way you edited

the text in the directory dialog window, and press the Return key. The other is to

move the slider to the new value. Hold down the Shift key to constrain motion to the

tic marks and move the slider pointer to 7, three minor tic marks below 10.

Shift key Most controls use the Shift key to constrain motion in some way natural to the control.

SciAn will calculate the new isosurface, which will appear in a few seconds.

Lighting

This section only applies to you if your workstation can do full color mode. Color

map mode does a kind of false lighting using a ramp of brightness values.
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SciAn automatically puts two lights in a visualization to illuminate the scene. Two

lights may not be enough, and the default location of the lights may not be quite right

for some datasets. It is therefore sometimes necessary to change the lights.

To move light sources, select their icons in the icon corral. The angle of incidence of

the light sources will be displayed in the space. To rotate the light sources around,

click and drag using the center mouse button within the space just as you would rotate

the objects within the space. You can create additional lights by selecting a light and

choosing Duplicate from the Object menu. You can turn lights on or off using the

Turn On and Turn Off items from the Object menu. You can change the color of

lights from within their control panels.

The highlights of visualization objects and how their surfaces are lit can be edited

using the Surface control set in the control panel of the visualization object.

Adding more visualization objects

SciAn chose the isosurface and mesh automatically, based on examining the data, so

that you could see a visualization as fast as possible. However, you are not limited to

SciAn’s choices.

Go to the Datasets window again. If it is hidden behind other windows, you can get it

back easily by choosing Show Datasets from the Datasets menu. Select the Z icon

and press the Visualize As button. Instead of a visualization window, SciAn will bring

up a new window containing all the different ways that the field can be visualized. See

Figure 1-9.

Visualize As 1

Visualize Z as..."! 
Mesh Template 1

Z 2-D slice

$#
Contours

! 
Mesh

'&
Isosurface

*)
Arrows

Visualize Show Controls

Figure 1-9. Visualize As window

At the top of the window is a series of buttons that represent different kinds of

visualizations. Click on the Mesh button. The corral will fill with icons representing

all the ways that the dataset can be visualized as a mesh. In this case, there will be only

one icon. Press on the icon using the left mouse button and drag it to the icon corral
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of the visualization window. A red ghost of the icon will follow the mouse cursor. Let

go of the mouse button to drop the icon in the corral.

A slice of the data will appear in the space. Show the control panel of the new

visualization object and click on the Slice icon. The slider on the left controls the

level of the slice, and the radio buttons to its immediate right control the axis over

which the slice is taken. Try moving the slider to move the slice up and down through

the field.

By default, a blue to red color palette is used to color all fields initially. Missing data

points are shown in dull gray. You can edit the color palette through a control panel.

This is described in Chapter 5.

Because of the directions of the lights, the slice may not be very well lit over all axes.

To fix this, click on the Surface icon in the control panel. At the right is a group of

three radio buttons that control light shading. Click on None, and the surface colors

will appear directly without shading.

Normally, colored objects smooth the shading between gridpoints to provide a

continuous image. It is sometimes desirable to see the grid, however. Go to the Color

attributes and press the Flat button in the color shading to do just that. You will

immediately see the grid.

Even in flat color shading mode, the color mesh object fills the cells between the grid

points and colors them using an average of the values at the points. To change this, go

into the Mesh controls and click on the Around Data Points radio button. When this

is set, the color cells will be extrapolated around data points rather than interpolated

between them.

Dressing Up the Visualization

In front of each 3-D space is a 2-D panel. You can draw on this panel to dress up

your visualization using the tools along the left side of the visualization window.

Using the left mouse button, click on the icon button for the Text tool. It is about

halfway down the set of tools at the left of the window and looks like a box with the

word Text inside. Then move the mouse into the space near the upper left corner.

Press down and hold the left mouse and drag down and to the right. Then release the

mouse button. A new text box will appear. To enter text into the box, just start typing.

If you look at the group of space tools at the left, you will notice that the space panel

selection icon is on. It looks like a hand pointing into a rectangle. When this tool is

selected, you can select, move, and resize the objects in the space panel. Using the left

mouse button, press and drag one of the eight square handles on the text box. You

will see the text box change in shape. Now try holding down the Shift key before

pressing and dragging. Motion will be constrained to an invisible grid on the screen.

Click somewhere else on the panel and the text box will be deselected. Click on the

text box and it will be selected again.
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Show the control panel for the text box by selecting it and choosing Show Controls

from the Object  menu. This control panel allows you to change the text and

background color as well as the style of the text box. The Text menu allows you to

change the font, size, and alignment of the text.

The other space tools below the Text tool allow you to draw rectangles, lines, and

clock readouts. Experiment if you like.

To delete an object on the space panel, select it and choose Delete from the Object

menu.

Conclusion

This tour has taken you through many of the basic features of SciAn. You should

now have all the basic knowledge to let you experiment with the features of SciAn.

SciAn is designed to encourage experimentation, and one of the best ways to learn

about it is simply to play around with the features. Remember, you can always get

help on any control using Help in Context.


